
1Bruker Optics GmbH & Co. KG OPUS License Agreement

Software License Agreement

This is a legal agreement between you (hereinafter referred to as LICENSEE)
and Bruker Optics GmbH & Co. KG, Rudolf-Plank-Straße 27, 76275 Ettlingen,
registered in the commercial register of the Local Court of Mannheim under
HRA 710333 (hereinafter referred to as LICENSOR). Carefully read all terms
and conditions of this agreement before opening the sealed disc package.
Opening the sealed disc package indicates your acceptance of the following
terms and conditions of this agreement. If you do not agree to the terms and
conditions of this agreement, return the unopened disc package to the LICEN-
SOR.

1. Subject of agreement

The program OPUS and software extensions of OPUS (hereinafter referred to as
SOFTWARE) and copyrighted libraries and other copyrighted digital data stored on
the delivered data medium (hereinafter referred to as DATA) and the accompanying
documentation are subject of this license agreement. The LICENSOR points out
that, according to the state of the art, it is not possible to create SOFTWARE and/or
DATA in a way, that they operate error free in any application and combination.
Therefore, only the SOFTWARE and/or DATA usable in terms of the user manual
and product description are subject of this agreement.

2. Grant of license and restrictions

The LICENSEE may install, run and/or use the SOFTWARE and/or DATA stored on
the delivered data medium on one (1) computer. If the LICENSEE wants to use the
SOFTWARE and/or DATA on more than one (1) computer at the same time the
LICENSEE needs to purchase additional licenses. 

The LICENSEE may store or install copies of the SOFTWARE and/or DATA on net-
works server only on the condition that this copy is used to install or run the SOFT-
WARE and/or use the DATA via network on one (1) computer. Sharing or using one
license for several computers at the same time is strictly forbidden. If LICENSEE is
using OPUS in combination with the OPUS/DLL package OPUS can be installed on
a second computer to allow configuration and servicing of the OPUS/DLL installa-
tion.
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3. Transfer restrictions

The LICENSEE may not transfer, loan, rent, lease or sell the SOFTWARE and/or
DATA or parts thereof either free of charge or against payment to any third party. If a
transfer of the SOFTWARE and/or DATA license is unavoidable (e.g. by selling the
spectrometer) this transfer can only be done by the LICENSOR. The LICENSEE is
obligated to inform the LICENSOR in time and in writing about the intended transfer.

4. Other restrictions

The LICENSEE may not modify, adapt, translate, reverse engineer, decompile or
disassemble the SOFTWARE in order to obtain the source code. The LICENSEE
may not use the DATA in a manner other than stated in the product documentation
or extract information from DATA in whatever form. Printouts or reproductions of the
DATA or parts thereof must be provided with a copyright note. 

5. Copyright and proprietary rights 

SOFTWARE, DATA, the accompanying documentation and each copy of SOFT-
WARE, DATA and accompanying documentation are proprietary of the LICENSOR
and are protected by copyright laws, international treaty provisions and all other
applicable national laws. Therefore, the LICENSEE must treat the SOFTWARE,
DATA and accompanying documentation like any other copyrighted material except
that the LICENSEE may either (a) make one (1) copy of the SOFTWARE and/or
DATA solely for backup or archival purposes or (b) transfer the SOFTWARE and/or
DATA to a single hard disk provided the LICENSEE keeps the original solely for
backup or archival purposes. The LICENSEE may not copy the written materials
accompanying the SOFTWARE and/or DATA. The LICENSOR points out that the
LICENSEE is liable for any damages arising from any copyright infringement.

6. Warranty and limitation of liability

The LICENSOR warrants that the SOFTWARE and/or DATA will perform substan-
tially in accordance with the accompanying product manuals for a period of 24
months from the date of receipt. Furthermore, the LICENSOR warrants that the data
medium on which the SOFTWARE and/or DATA are recorded shall be free from
defects in materials and workmanship under normal use and service for the same
period. If the data medium, on which SOFTWARE and/or DATA are recorded, is
defective, the LICENSEE must return the defective data medium to the LICENSOR
and the LICENSOR will replace it at no charge.
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For the reasons named under provision 1 the LICENSOR does not warrant that the
SOFTWARE, DATA and accompanying documentation are error free. The LICEN-
SOR disclaims all warranties, either express or implied, including but not limited to
warranties of fitness for a particular purpose and the compatibility with other soft-
ware programs or hardware components. The LICENSEE assumes full responsibil-
ity for the selection of the software and the consequences resulting from the use of
the software. The LICENSEE assumes also the entire risk as to the intended or
achieved results. The LICENSOR is only liable in cases of intention and gross neg-
ligence.

The LICENSOR shall not be liable for any special, incidental, indirect or consequen-
tial damage of any kind or other damages whatsoever (including, but not limited to
damages for loss of business profits, business interruptions, loss of business infor-
mation or other pecuniary loss) arising out of or in connection with the use or non-
use of the SOFTWARE and/or DATA, even if the LICENSOR has been notified of
the possibility of such damages. In any case the LICENSOR'S entire liability shall
not exceed the actual amount of money paid by the LICENSEE for SOFTWARE and
DATA. Some states and jurisdictions do not allow the exclusion or limitation of liabil-
ity for consequential or incidental damages, so the above limitation or exclusion
may not apply in any case. 

The SOFTWARE is pre-configured such that the LICENSEE can use it in compli-
ance with data protection. The LICENSEE is, however, responsible for the effective
implementation of the software use in compliance with data protection. In this con-
nection, the LICENSOR does not warrant that the LICENSEE has implemented all
data protection requirements of the European General Data Protection Regulation
(GDPR) when using the software. Any claims made against the LICENSOR which
are based on the violation of data protection obligations on behalf of the LICENSEE
are excluded.

7. Term and termination

This license is effective until terminated. The LICENSEE'S rights under this license
will terminate automatically without notice from the LICENSOR if the LICENSEE
fails to comply with any term or condition of this license. In this case the LICENSEE
is obligated to return immediately the original and all copies of SOFTWARE, DATA
and accompanying material to the LICENSOR.
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8. Miscellaneous provisions 

Place of jurisdiction for any legal dispute arising out of or relating to this agreement
is Karlsruhe. If any provision of this agreement is deemed invalid or incomplete,
partly or entirely, the remaining provisions will remain in full force and effect.

Status: December 2021
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All rights reserved. No part of this user manual may be reproduced or transmitted in
any form or by any means including printing, photocopying, microfilm, electronic sys-
tems etc. without our prior written permission. Brand names, registered trademarks
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1 Introduction

1.1 About this manual

This manual is a quick reference guide about the OPUS spectroscopy software. For
important information the manual uses the following format:

i The i provides important information given to the user to facilitate system operation,
and make the best possible use of the software.

1.2 Terms

This manual uses the term OPUS when the software is described.

1.3 Gender-neutral form

The user manual uses the male form in a neutral sense and does not differentiate
between male, female and diverse users. We would kindly ask the users to have
understanding for the male form which only serves to simplify the creation of this
manual.
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1.4 Questions and concerns

If you have questions or concerns about operating the software, contact Bruker at
the numbers listed below:

• Service hotline: +49 (0) 72 43 504-2020
• Fax: +49 (0) 72 43 504-2100
• E-mail: service.bopt.de@bruker.com

service.bopt.us@bruker.com
• Internet: www.bruker.com/optic
• International service: www.bruker.com/about-us/offices/offices/

bruker-optics
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2 Installation Instructions

2.1 System requirements for software

PC data system: • serial interfacea

• Ethernet, RJ45, 10Base T (10 or 10/100MHz)
• USBb

• Mouse, keyboard
• PCI-x1 interfacec

Processor: 64 bit processor

RAM: 4 GB

Hard disk: 250 GB, IDE

Graphics card: XVGA, >128MB RAM, 32 color-bit depth, open GL 
and support of Direct-X, version 9 or higher (for 
OPUS/VIDEO, OPUS/3D)

Monitor: Minimum resolution:
1024 x 768

Recommended resolution:
1600 x 1200

Operating system: Minimum (OPUS 8 and higher):
Windows 10 (Home Premium or better 64 bit)

Table 2.1:  System requirements for software
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Ethernet: Windows 10 with OPUS 8 or higher:
• Internet explorer 11
General (for any OPUS version):
• TCP/IP must be configured
• Address range of PC network card must include 

spectrometer IP
• Port 80 to spectrometer via network card must be 

available
• Proxy is not allowed to interfere with the communi-

cation to the optics
• No USB port restrictions

a.  Only required when connecting external devices, e.g. temperature controller, xy stage controller etc.

b.  USB 2.0 is required to load OPUS software, and operate the digital video cameras built-in the Ra-
manscope III, SENTERRA (2x). USB 3.0 is required to operate the LUMOS IR microscope.

c.  Some types of accessories (e.g. A673-X, A750/x, S522-20, S522-200, Frame-Grabber etc.) require a
data system which is able to accommodate one or more cards with full length.

Table 2.1:  System requirements for software



9Bruker Optics GmbH & Co. KG OPUS Introduction
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2.2 Access rights

• Windows Administrator rights required to install or register OPUS
• Complete write access required to the target path
• Complete access required to USB ports, no restrictions on access rights by

services such as DeviceLook Service

2.3 Miscellaneous

Configure Windows so that it is possible to see the file extensions of registered file
types.

1. Open the Windows Explorer.
2. On the Tools menu, click the Folder Options command.
3. Click the View tab.
4. Delete the checkmark in front of the Hide extensions for known file types

option.
5. Click OK to confirm the settings.

2.4 Installing OPUS using Windows 10

When using Windows 10 it is not sufficient to be logged into the operating system as
a user with Administrator rights. You need to perform the installation explicitly as
administrator (chapter 3.1).
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2.5 Modifying, repairing or removing single OPUS features

i For technical reasons not all features are deleted when de-installing the OPUS pro-
gram. If you want to remove OPUS completely, you have to delete the OPUS direc-
tory manually after de-installation. Before you do this, store all important data (e.g.
workspaces, printing templates, macros etc.) in a different directory.

1. Click the Windows Start menu.
2. Select the Control Panel command.
3. On the view that opens, select the Programs and Features command.
4. Right click the current OPUS version installed.
5. From the pop-up menu displayed, select the Change command.
6. On the view that opens, check the particular option button depending whether

you want to modify, repair or remove OPUS features.
7. Click the Next button.
8. Use the InstallShield Wizard to make the settings.
9. Click the Finish button.
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3 Installing OPUS

i By default, the OPUS spectroscopy software is supplied on a USB stick.

3.1 Installation procedure

i Installing OPUS requires Administrator user rights.

1. Insert the OPUS stick supplied into the USB port of your PC. 
2. If the installation starts automatically after inserting the OPUS stick, interrupt

the installation procedure.
3. In the OPUS_<version> installation directory, right click the setup<nn>.exe file. 
4. From the pop-up menu that opens, select the Run as Administrator option.
5. Confirm the message that pops up to be able to continue.
6. Follow the on-screen installation instructions and enter the OPUS registration

data.1

 A print-out of the registration data is annexed to the OPUS stick. The regis-
tration has to be performed only once and is valid for all users.

1.  If you want to install an OPUS test version (valid for 30 days), you do not need to enter any registra-
tion data. In this case, set a checkmark for the test option.
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7. If OPUS is to run in the 21 CFR Part 11 operating mode (validation mode), acti-
vate the particular option.1

 If OPUS 8 or higher is to run in the validation mode, it is recommended to
work with a database. The connecting option to a database (OPUS data-
base or user-specific database) can be activated during installation. If
required, the setting made can only be undone later by a user with Windows
administrator rights.

8. Select the language to be used for OPUS.
9. Restart the PC at the end of the installation procedure.

 If you are prompted to restart your computer when you install different pro-
gram components, do NOT restart before the OPUS setup has been com-
pleted.

3.2 OPUS Login

1. When the installation has been finished, click the OPUS icon on the Windows
Start menu.

2. On the dialog that opens, select the user ID2 from the drop-down list.
3. Enter OPUS as password.

 The password is case sensitive. Once you have assigned yourself a user
account in OPUS, it is possible to determine your own user ID and pass-
word. When working in validation mode, you will be requested to change the
password immediately after the first login. Details are described in
chapter 3.2.1.

4. Select a workspace.

1.  The option can only be activated if the OPUS registration contains the OPUS/VALIDATION software 
package. Activating the option cannot be undone and has comprehensive effects when working with 
OPUS. 21 CFR part 11 is a quality regulation legally approved by the United States Food and Drug 
Administration (FDA), which also regulates the requirements on data integrity. If OPUS 8 or higher is 
to run in the validation mode, it is recommended to work with a database. The option to be connected 
to a database (OPUS database or user-specific database) can only be activated during installation.

2.  By default, OPUS provides the following user IDs: Admin, LabManager and Operator. Detailed infor-
mation on the user ID are described in the OPUS Reference Manual.
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 You can always select those workspaces from the drop-down list which
have been defined for your user ID. When you use OPUS for the very first
time, we recommend to accept the standard ’default.ows‘ workspace.

5. Click the Login button.
6. On the dialog that opens, click the OK button.

 The OPUS user interface opens.

3.2.1 Changing password in the validation mode

1. After the very first OPUS login you are requested to change the password.
Click OK to confirm the request.

2. In the dialog that opens, enter the new password and verify it.
 According to the 21 CFR Part 11 operating mode (validation mode) the

password has to comply with special complexity requirements, therefore has
to fulfill the following minimum conditions:
 Total length: 8
 Number of numerals: 1
 Number of letters: 1
 Number of lower case letters: 1
 Number of upper case letters: 1
 Number of special characters: 1

3. Click the Change Password button.
4. In the Login dialog, enter the new password and click the Login button.
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3.3 OPUS user interface

Element Definition

1 Title bar The title bar shows the user ID and the work-
space assigned to the user.

2 Menu bar The menu bar shows all menus available in 
OPUS. The individual menus allow access to 
all OPUS commands.

Table 3.2:  Elements of OPUS user interface

1
2

3

5

6

4

7
8 9 10

Figure 3.1: OPUS user interface
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3 Toolbar The toolbar contains frequently-used OPUS 
commands, individually configured by means 
of icons.

4 Browser The browser shows the spectrum files loaded, 
with the particular data blocks.

5 Spectrum window The spectrum window shows the spectrum file 
loaded. By default, a crosshair is displayed. 
The current position of the crosshair (e.g. 
wavenumber and intensity) are displayed on 
the upper right edge. This allows to read out 
the x/y positions directly from the spectrum. 
Right clicking the spectrum window hides the 
crosshair.

6 Overview window The overview window shows the complete fre-
quency range of the spectrum file loaded.

7 OPUS view The OPUS view you work with is indicated by 
a tab. Each tab has a different color to be able 
to distinguish between the OPUS views. If 
several OPUS views are open simultaneously, 
click the respective tab or use the buttons on 
the left and right to change between the differ-
ent OPUS views.

8 Online help The OPUS online help provides detailed infor-
mation on all OPUS commands and can be 
opened by clicking the F1 key.

Element Definition

Table 3.2:  Elements of OPUS user interface
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9 Status bar The status bar informs about active tasks cur-
rently running in OPUS Introduction, and 
shows their status.

10 Instrument status The instrument status is indicated by the 

OPUS status light ( ) as follows:
• Gray: no spectrometer connected
• Green: spectrometer connected
• Yellow: warning
• Red: error

Element Definition

Table 3.2:  Elements of OPUS user interface
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3.4 Access control

OPUS has an access control system which is shown in figure 3.2.

3.4.1 User record

The user records in the OPUS user database comprise:

• User ID
• Password
• Operator name
• User group (Administrator, Operator)
• Signature categories
• Accessible workspaces

Figure 3.2: Access control in OPUS
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3.4.2 OPUS workspace

The workspaces comprise:

• Menu contents
• Toolbar contents
• Access rights within OPUS
• Other settings (e.g. file increment mode, display limits)

Detailed information on the user management e.g. to add, modify or remove users
from the user database are described in the OPUS Reference Manual.

3.4.3 Data recording

In OPUS, details on the single manipulations and/or evaluations on spectra files are
saved in the HISTORY data block (chapter 4.3).

In addition, the global audit trail logs all actions which have been performed in
OPUS in connection with the user and signature management, as well as with the
single spectrum file, within a defined period of time.

Next to the type of action the global audit trail also shows the user ID of the user
who is responsible for this action. Details on the global audit trail are described in
chapter 4.4.
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4 Working with OPUS

4.1 Measuring a spectrum

Chapter 4.1 et seq. describes the individual steps to be performed or observed
BEFORE, DURING or AFTER measuring spectra. Observe the order of the steps
described.

The dialogs depend on the spectrometer configuration currently used. Therefore,
the following dialogs may be slightly different from the ones displayed on your
screen.

4.1.1 Connecting to spectrometer

1. On the Measure menu, select the Optic Setup and Service command, or click

the  icon from the toolbar.
2. In the dialog that opens on the Optical Bench tab, check whether the spectrom-

eter settings are OK. If yes, close the dialog. If no, continue with step 3.
3. From the Configuration drop-down list, select the particular spectrometer type.
4. Enter the spectrometer’s IP address into the Optical Bench URL entry field.
5. Click the Connect button.
6. Wait until the connection to the spectrometer has been established.

 The spectrometer is connected as soon as the spectrometer name and firm-
ware version are displayed (figure 4.3). If the connection has been success-
ful, the OPUS status light is green.
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7. Click the Save Settings button.

Figure 4.3: Spectrometer connecting data
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4.1.2 Setting up measurement parameters

1. On the Measure menu, select the Measurement command, or click the 
icon from the toolbar. 

2. On the dialog that opens, define the measurement parameters on the different
tabs. 
 To learn more about error diagnostics when setting measurement parame-

ters refer to chapter 4.1.2.1. Details on the individual measurement parame-
ters are described in the OPUS Reference Manual.

3. Click the Accept & Exit button.
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4.1.2.1 Error diagnostics when setting measurement parameters

Display in OPUS Meaning

The yellow exclamation mark indicates that 
the particular tab contains a warning for one 
or more measurement parameters.

i Measurement still possible.

Example:

 Yellow marking in front of the drop-down list or in the entry field of a measurement
parameter.

 If you position the cursor on the drop-down list or entry field, a tooltip explains why a
warning is available for the particular measurement parameter.

Table 4.3:  Error diagnostics when setting measurement parameters
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The warning symbols indicate that the particu-
lar tab contains one or more measurement 
parametersa, which are missing or have not 
been correctly defined as they do not match 
the optic configuration.

i Measurement not possible.

Example:

 Red marking in front of the drop-down list or in the entry field of a measurement
parameter.

 If you position the cursor on the drop-down list or entry field, a tooltip explains the
missing or wrong measurement parameter.

a. Some types of measurement parameters interact with other ones, i.e. if one measurement parameter is corrected,
the warning indicated for other measurement parameters affected by the correction may no longer apply.

Display in OPUS Meaning

Table 4.3:  Error diagnostics when setting measurement parameters
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4.1.3 Calibrating interferogram peak

i The exact interferogram peak position must be determined and stored BEFORE the
very first measurement. Once determined, the interferogram peak position must be
determined only if hardware changes have arisen.

1. On the Measure menu, Select the Advanced Measurement command.
2. Click the Check Signal tab.
3. On the dialog that opens, activate the Interferogram option button.
4. Use the arrow buttons (figure 4.4) to move the scan region to the left or right if

no interferogram peak is displayed.

5. Click the Save Peak Position button to store the interferogram peak.
 The exact peak position is required to be able to perform Fourier Transfor-

mation.
6. Click the Accept & Exit button.

Figure 4.4: Moving scan region
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4.1.4 Storing experiment file

1. On the Measure menu, select the Advanced Measurement command.
2. Click the Advanced tab.
3. On the dialog that opens, define the number of scans in the Sample/Back-

ground Scan Time entry fields (figure 4.5).

4. Define the path to automatically store the measuring data, e.g. *\MEAS.

 Use the  button to exactly select the storage path. If OPUS is to run in
the validation mode, special requirements on the storage path must be ful-
filled. Details are described in chapter 4.1.4.1.

5. Determine the data type for the result spectrum. 
 It is recommended to select ’Absorbance’ as result spectrum data type.

Figure 4.6 shows possible result spectrum data types.

Figure 4.5: Defining number of scans
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 The data type of the result spectrum can be changed at any time.
6. Click the Save button.
7. On the dialog that opens, define a name for the experiment file and save this

name. 
 It is recommended to repeatedly use the experiment file. When working with

macros, experiment files are essential.

4.1.4.1 Storing path in the validation mode

When working in the validation mode, files have to be saved into a protected data
pool. The term protected data pool1 refers to public directories and sub-folders in
the C:\Users\Public\Public Documents\Bruker\OPUS_<version> path.

Paths which do not exclusively use public directories and/or sub-folders are not
accepted by OPUS, and the user will not be allowed to save spectrum files into
these directories.

Figure 4.6: Result spectrum data types

1.  In the protected data pool files can be edited but not deleted nor overwritten. Programs other than 
OPUS have no access to the files stored in the protected data pool.
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4.1.5 Measuring background spectrum

In case of a background spectrum you measure an open-beam spectrum without
any sample in the optical path. Therefore, a background spectrum is also called sin-
gle-channel reference spectrum. Before starting sample measurement you have to
measure a background spectrum, if not yet available.

The background spectrum reflects the effects that the spectrometer itself has on
measured spectra. For example, the performance of the light source varies at some
frequencies, or the optics absorbs light stronger at a certain wavelength.

1. Make sure that the OPUS status light is green.
2. Make sure that there is no sample available in the sample compartment.
3. On the Measure menu, select the Advanced Measurement command.
4. Click the Optic tab.
5. On the dialog that opens, click the Aperture setting drop-down list and select

the same value used to acquire a sample spectrum.
6. Click the Basic tab.
7. On the dialog that opens, click the Background Single Channel button.

 The status bar below the spectrum window indicates the progress of the
background measurement, e.g. the number of scans already measured.
Background measurement has finished if the status bar reads ’No Active
Task’.

8. Wait until the background measurement has finished, then measure the sample
spectrum (chapter 4.1.6).

4.1.6 Measuring sample spectrum

1. If the background measurement (chapter 4.1.5) has finished, place the sample
into the optical path of the spectrometer.
 How to do this depends on the spectrometer configuration.

2. On the Measure menu, select the Advanced Measurement command.
3. Click the Basic tab.
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4. On the dialog that opens, define the sample description and sample form in the
particular entry field.
 This information is stored together with the spectrum.

5. Click the Sample Single Channel button to start measurement.
 The ’Measurement’ dialog closes and the spectrum window opens. The sta-

tus bar below the spectrum window indicates the progress of the sample
measurement. The sample measurement has finished if the measured
spectrum is displayed in the spectrum window (figure 4.7).

Strictly speaking, the spectrometer measures an interferogram rather than a spec-
trum. Using Fourier Transformation this interferogram is transferred into a sin-
gle-channel spectrum. On the basis of this single-channel spectrum and the
background spectrum measured, a result transmission spectrum is calculated.

Figure 4.7: Measured sample spectrum displayed in the spectrum window
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To better understand the different types of spectra, figure 4.8 shows the sin-
gle-channel spectrum, background spectrum and the calculated transmission spec-
trum. The particular data blocks are displayed in the browser. 

Details on the data blocks are described in the OPUS Reference Manual.

Definition Data block in the browser

1 Transmission spectrum TR

2 Background spectrum (single-channel) RSC

3 Sample spectrum (single-channel) SSC

Table 4.4:  Definition of spectrum types

1

2

3

Figure 4.8: All spectrum types of a measured sample spectrum
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4.2 Baseline correction

Directly after sample measurement has finished, the baseline correction is useful to
manipulate spectra which could not have been measured very well due to the sam-
ple material available.

If the baseline of the spectrum is sloped, curved or significantly below 100% trans-
mission, the sample preparation might have been insufficient. Instead of measuring
the sample again, perform a baseline correction. In many cases, this will solve the
problem.

However, you should always try to prepare the samples properly to get good spec-
tra, instead of correcting them after measurement.

Figure 4.9 shows an example for baseline correction. The upper spectrum is the
original spectrum, the lower one is baseline corrected.

Figure 4.9: Spectrum before (top) and after (bottom) baseline correction
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4.2.1 Performing baseline correction

1. On the Manipulate menu, select the Baseline correction command, or click the

 icon from the toolbar.
2. On the browser, double click the spectrum block (AB or TR) of the sample

spectrum measured.
 The spectrum file is displayed in the ’File(s) to correct’ selection field.

3. Click the Select Method tab.
4. On the dialog that opens, select a baseline correction method (figure 4.10).

 Details on the single method types are described in the OPUS Reference
Manual.

5. Enter the number of baseline points manually.
 It is recommended to accept the default value of 64.

6. Activate the Exclude CO2 bands checkbox to exclude the CO2 range during
baseline correction.

7. Click the Correct button.
 Baseline correction will be executed immediately.

The browser window shows a red document symbol (figure 4.11) on top of the blue
document symbol (original data). The red document symbol indicates that the spec-
trum file has been manipulated.

Figure 4.10: Baseline correction - Select method
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4.2.1.1 Baseline correction completed

After baseline correction has been completed the spectrum has not yet been saved
to hard disk and exists only as a temporary file. Save the file on hard disk, use a dif-
ferent file name to prevent the original file from being overwritten (chapter 4.5.2).

4.2.1.2 Undo baseline correction

1. On the browser, right click the red document symbol. 
2. From the pop-up menu that opens select the Undo all Manipulations command.
3. On the dialog that opens, click the Undo button (figure 4.12).

Figure 4.11: Spectrum file displayed in 
browser after baseline correc-
tion 
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 The red document symbol is no longer displayed in the browser, and the
original data are available again.

4.3 History of spectrum files

If a spectrum file loaded has been edited or changed or if global measuring settings
have been changed, all these actions can be viewed in the non-editable, non-delet-
able history data block ( ).1

Figure 4.13 shows parameters from a HISTOTRY data block of a spectrum file with
several types of manipulations performed.

Figure 4.12: Undo baseline correction

1.  In addition, OPUS uses the global audit trail to report and log measurements, manipulations and/or 
evaluations of spectrum files, as well as changes made on particular setting options.
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 To have the parameters displayed right click on the red document symbol and
select the Show Report command.

The HISTORY data block contains the following parameters:

• user ID
• OPUS version
• spectrum file name
• all previous manipulations (in the order of performance)

The parameters are stored in one single spectrum file, together with the spectrum
edited. This ensures that all data manipulations are recorded, e.g. type of manipula-
tion method, time etc.

Figure 4.13: Parameters of HISTORY data block
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4.4 Viewing global audit trail

i The global audit trail records all actions which have ever been taken in OPUS, in
chronological order. Details on the global audit trail are described in the OPUS Ref-
erence Manual.

1. On the Validation menu, select the View global audit trails command.
2. In the view that opens, define a start and end date for the search period.
3. Click the Request button.

 The query result is displayed in chronological order in a table (figure 4.14).

Figure 4.14: Example of a global audit trail result view
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4.4.1 Loading HISTORY data block from global audit trail

i Modifications performed on a spectrum file are saved in the HISTROY data block,
which is added to the spectrum file. The HISTORY data block can be directly loaded
from the global audit trail for a particular spectrum file.

1. In the result view of the global audit trail, search the spectrum file which has
been modified.

2. Double click the name of the modified spectrum file in the Object Snapshot col-
umn.
 The parameters of the HISTORY data block are displayed in a separate

report view.

4.5 Saving spectrum

i By default, the sample spectrum measured (original file) is saved in the path defined
in chapter 4.1.4. If the original file has been manipulated, it is recommended to save
the original file by using a different file name (chapter 4.5.2), to prevent the original
file from being overwritten. Once overwritten, restoring the original file is not possi-
ble anymore.

4.5.1 Saving and overwriting the original file

1. On the File menu, select the Save File command, or click the  icon from
the toolbar.

2. On the dialog that opens, drag & drop the spectrum file from the browser to the
File(s) to save list box.
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3. Click the Save button.
 The original file is overwritten. Restoring the original data is not possible

anymore.

4.5.2 Saving without overwriting the original file

1. On the File menu, select the Save File As command, or click the  icon from
the toolbar.

2. On the dialog that opens, drag & drop the spectrum file from the browser to the
File to save (OPUS format) list box (figure 4.15).

3. Define the file name.
 By default, OPUS provides a file name which can always be changed.

4. Define the path.
 The ’Change Path’ button allows to exactly select the storage location.

Figure 4.15: Save File As
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5. Activate the ’Overwrite’ checkbox if a previous file is to be overwritten.
 If the checkbox is deactivated, the file name is incremented. The ’Overwrite’

checkbox is disabled when the spectra have been measured in validation
mode.

6. Make the settings on the Mode and Data Point Table/XML tab.
 The spectrum file is normally saved in OPUS format. However, the ’Mode’

and ’Data Point Table/XML’ tabs allow to save the file in different formats,
e.g. JCAMP-DX or XML format, as a plain XY data table, in Pirouette (DAT)
or in GALACTIC format (SPC). Details on the tabs are described in the
OPUS Reference Manual.

7. Click the Save button.

4.6 Load spectrum file

1. On the File menu, click the Load File command, or click the  icon from the
toolbar.

2. On the dialog that opens, select the particular spectrum file.
 The dialog is described in chapter 4.6.1.

3. Click the Open button.
 The spectrum is displayed in the spectrum window.
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4.6.1 Description of Load Spectrum dialog

Element Definition

1 Title bar The title bar shows the directory in which the 
spectrum files are saved.

2 Spectrum files Depending on the data type (4) selected all 
spectra files are displayed, which are avail-
able in the particular directory.

3 Preview The preview shows the spectrum without 
axes, and the data blocks of the spectrum file. 

Table 4.5:  Elements of the Load File dialog

1

2

3

4

5

Figure 4.16: Load Spectrum dialog
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4 Data type The drop-down list contains different data 
types. Spectra measured in OPUS have the 
OPUS Spectrum data type.

5 Parameter By default, 3 parameters are displayed per 
each spectrum file. The drop-down lists con-
tain different types of parameters. 
If a spectrum file has been selected, the val-
ues are displayed next to the parameters on 
the right (figure 4.16). As not all parameters 
must be specified for each spectrum, some of 
the parameter values may be missing even if 
the spectrum file has been selected.

Element Definition

Table 4.5:  Elements of the Load File dialog
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4.7 Printing spectrum file

4.7.1 Using the Quick Print command

 On the Print menu, select the Quick Print command, or click the  icon from
the toolbar.
 Depending on the window type currently used, OPUS selects an appropriate

plot layout. For example, if you work in the spectrum window, the spectrum
will be printed within a frame. If you search a spectrum library, the results as
well as a hit list, spectral information and the structure of the product will be
printed. More details on pre-defined layout plots are described in the OPUS
Reference Manual.

4.7.2 Using the Print Spectra command

1. On the Print menu, select the Print Spectra command, or click the  icon
from the toolbar.

2. On the dialog that opens (figure 4.17), you can individually define the basic set-
tings for the print-out.
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3. Select a layout.
4. If required, make further settings on the Frequency Range or Options tabs.

 More details on the single tabs are described in the OPUS Reference Man-
ual.

5. Click the Print button.

Figure 4.17: Print Spectra dialog
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OPUS allows to depict sample parameters and evaluation results for one or several
spectrum files in an analysis report. The spectra files need to contain the data block
of the respective evaluation. Evaluation data blocks are e.g. PEAK, INTEG, QUANT,
IDENT, SEARCH, CT.

5.1 Generating report

1. On the Print menu, select the Generate Analysis Report command, or click the

 icon from the toolbar.
2. On the dialog that opens, click the Load button.
3. Select the particular spectrum file and click the Open button.

 The spectrum file is displayed in the ’File(s) for report generation’ list box
(figure 5.19).

Figure 5.18: Spectrum file with data blocks
of different evaluation types
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4. Define the report layout.
 Single sample report1: one report for each spectrum file
 Multi sample report2: one report for all spectrum files

5. Select the template file.
 By default, OPUS provides several types of template files. Template files

have the extension *.art and are stored in the C:\Users\Public\Public Docu-
ments\Bruker\OPUS_<version> directory.

6. Click the Output to tab and define how the report is to be printed.
 If you want to print the report as PDF or csv file, you have to define the file

name of the report and the path to store the report.
7. Click the Generate button.

1.  To generate a single sample report you can use several spectra files at once. In this case, a separate 
report will be generated for each spectrum file separately.

2.  A multi sample report lists all spectrum files with the respective data in one report.

Figure 5.19: Generating analysis report
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